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MSP430FR5994 Ultrasonic Gas Meter — Quick Start Guide

Luis Reynoso MSP Systems Applications

ABSTRACT

This quick start guide explains how to build and run an Ultrasonic Gas Meter demo using
the MSP430FR5994.

More information about the application can be found at: http://www.ti.com/tool/TIDM-1002.
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Hardware

The demo includes and requires the following hardware:
Table 1: Hardware Used for Ultrasonic Gas Meter Demo

1.1 MSP-EXP430FR5994

1.2 Ultrasonic AFE BoosterPack

1.3 Gas Pipe and Transducers

1.4 Fan with Pipe Connector

1.5 DC Power Supply *

1 Not included

MSP-EXP430FR5994

The MSP-EXP430FR5994 is the EVM used to program, debug and execute the
application on the MSP430FR5994 MCU.

More information about the MSP-EXP430FR5994 is available at:
http://www.ti.com/tool/msp-exp430fr5994

The default configuration is shown in the following figure:

J101-GND: ON
J101-5V: ON
J101-3V3: ON
J101-RXD: ON
J101-TXD: ON

: '1 -t R Temuments DAL 2 1101-SBWTDIO: ON
S = i J101-SBWTCK: ON

18: OFF

J7:0N

Figure 1: MSP-EXP430FR5994 Default Configuration

MSP430FR5994 Ultrasonic Gas Meter — Quick Start Guide
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1.2

1.3

Ultrasonic AFE BoosterPack

TIDM-1002 uses the Ultrasonic AFE BoosterPack to demonstrate the implementation of
an Ultrasonic gas meter with MSP430FR5994.

The default configuration of the BoosterPack is shown in the following figure:

JP2: 3V3TX

JP1: OFF

11/12:
Connected to
transducers

J3: OFF
J4: OFF

Figure 2: Ultrasonic AFE BoosterPack Default Configuration

Gas Pipe and Transducers

The demo might include a pipe with 2 transducers. There are different types of
transducers used for demo purposes but the pipe should include a label showing the

transceiver type.

The picture below shows two types of pipes used for demo purposes:

Mini—X
Audiowell-300

Figure 3: “Mini-X” and ‘V’ Pipes with Audiowell Transducers

MSP430FR5994 Ultrasonic Gas Meter — Quick Start Guide
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Note:

The meter pipe and transducers included in your demo might be
different from the pictures above. Please check the label to
distinguish the meter.

1.4 Fan with Pipe Connector

The demo might include a 12V DC fan used for demo purposes. The fan is controlled by a
DC voltage and is taped to a PVC pipe which can be attached to the meter pipe.

=3
=5

= \

Figure 4: DC Fan with Pipe Adapter

1.5 DC Power Supply

The demo doesn’t include but uses a DC Power supply to control the fan. One example is
shown in the following picture:

Figure 5: DC Power Supply

4 MSP430FR5994 Ultrasonic Gas Meter — Quick Start Guide
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2 Demo Software Package Contents

The contents of the software package used for demo purposes are shown in Table 2.
Table 2: Demo Software Package Contents

File/Folder Description

binaries/ Folder with pre-built binary files to load demo without building

IAR/CCS projects

FR5994GasDemo_QS.pdf

This document

MeterConfig/

Folder with configurations used to test different
meters/transducers

gasLibrary_1_10_00_11_windows_installer.exe

Installer of Gas Library including example

MSPFlasher_1.3.10.zip

MSP Flasher used to load binaries to the device

tidud03.pdf

User’s Guide for Ultrasonic Gas Meter Tl Design

USS_GUI_1_00_02_04.zip

GUI used to configure device and run demo

2.1 Software Preparation

1. Extract USS_GUI_1_00_02_04.zip to the folder of your preference.

) =NREN X |
@'\J=| « OSDisk (C:) » US5_GUI1.000204 » h USS_GU_1_00 |
Organize » | £ Open = MNew folder B= -« [ L@:
=
¥ Ea i MName Type Siz,
. backup File folder
W (= configFiles File folder
J lib File folder
| lo File folder
9
y third_party File folder
| € MSP430UltrasonicConfigurationTool_ma... Chrome HTML Do...
| %] mebeSerial.dil Application extens...
! 4] USS_GULjar Executable Jar File
I
|
] T 3
USS_GULjar Date modified: 11/21/2016 11:22 AM
| Executable Jar File Size: 417 KB

Figure 6: USS GUI Folder

2. (Optional): Install gasLibrary_1_10_00_11_windows_installer.exe to be able to modify
and rebuild the application using CCS or IAR as described in Appendix B and
Appendix C.

3. (Optional): Extract MSPFlasher_1.3.10.zip to be able to re-flash the MSP430FR5994 as
described in Appendix A.

MSP430FR5994 Ultrasonic Gas Meter — Quick Start Guide 5



I3 TeExas
INSTRUMENTS

Running the Demo

1.

2.

Set hardware in Default configuration as shown in Figure 1 and Figure 2.

The MSP430FR5994 should come pre-programmed and ready to run, but if
necessary, re-flash the device following the steps described in Appendix A.

Connect MSP-EXP430FR5994 to Ultrasonic AFE BoosterPack aligning the
Launchpad/BoosterPack connectors as shown in the following figure:

Figure 7: MSP-EXP430FR5994 Connected to USS AFE BoosterPack

Connect the transducer terminalto the USS AFE BoosterPack.

The transducers should be connected to J1 and J2 in the Boosterpack, with the black
cable connected to each GND pin. The order of the connections is only important to
determine the direction of air flow.

Figure 8: Transducers connected to EVM

MSP430FR5994 Ultrasonic Gas Meter — Quick Start Guide
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5. Connect the MSP-EXP430FR5994 to the PC through USB using J102 connector.
6. Connect the DC fan to the ultrasonic pipe.

7. Connect the fan’s positive (red) and negative (black) terminals to the DC power supply
as shown in Figure 9:

Transducer lines
toJlandlJ2in
USS AFE BP

Figure 9: Connections of Ultrasonic Gas Meter Demo

8. Open the folder where the Ultrasonic GUI was extracted to (USS_GUI_1_00_02_04.zip)
and run the GUI by double-clicking USS_GUl jar.
The GUI will start running in the disconnected state.
The GUI should run after a splash screen displaying the disconnected state:

MSP430FR5994 Ultrasonic Gas Meter — Quick Start Guide
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[ MsPa30™ Uttrasonic Sensor Tool [Ep =
File Help
| Configuration | Waveforms T ADCWavefnrmw
Serial Communication

Comm Ports Available: | COM3

7] | Refresn |

Serial Communication Setting: 57600/8N1

Software Parameter

Transmit frequency (KHz):

Number of Pulses:

UPS and DNS gap:(usec)

DNS and UPS gap (msec).

GUI based gain control.

Meter constant

il

Gap between pulse start and ADC capture: (pusec)

1200 iz 2000

112.6

Pattern3 v |

Request Update

Load Configuration

Save Configuration

Ready

Figure 10: Disconnected USS GUI

9. The GUI will display all connected and enumerated COM ports. Select the port “MSP

Application UART1".

-
& MSP430™ Ultrasonic Sensor Tool

File Help

[ configuration | waveforms | ADG Waveform |

Serial Ct
Comm Ports Available: | Refresh |
COM12 4
Serial Communication § nopq3
Software Parameter cotn
COoMz20
Transmit frequency (KHz COM21 f2: 200.0
Gap between pulse star| COM22 150 22
|
/)
MNumber of Pulses WMEP Debug Interface (COMZ2: v 40 \i'
UPS and DNS gap:(usec) 8,000 \i'
DNS and UPS gap (msec): 850 L:,

Figure 11: Selecting the COM port

MSP430FR5994 Ultrasonic Gas Meter — Quick Start Guide
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10. Click the “Connect” Button. The GUI should go to the connected state
®3 MSP430™ Ultrasonic Sensor Tool (o[=] = |
File Help
J Configuration TWaveforms T ADC Waveform }
Serial Communication
Comm Porls Available: | MSP Application UART1 (COM2, Refresh Disconnect I}
Software Parameter
Transmit frequency (KHz): f1 1200 f2 2000 \ Pattern 3 T Request Update
Gap between pulse start and ADC capture: (usec) 450
Number of Pulses 40 B
UPS and DNS gap:(usec) 8,000 B Load Configuration
DNS and UPS gap (msec): 850 Save Configuration
GUI based gain control: 1] B
Meter constant: 1126
UPS (N pulses) DNS (N pulses) UPS (N pulses) DNS (N pulses)
|_ upsandDNsgap | | DNSand UPS gap |
. |
Ready

Figure 12: Connected USS GUI

11. Click on “Load Configuration” and select the configuration file inside MeterConfig/
corresponding to your meter and transducers:

*3 Open @

LookIn: | (E5 MeterConfig "] || | @ lE]l 8l |

|| MiniX-audiowell300_FR5994
| | V_audiowell300_FR5994
| V_ceramtec400_fr5994

File Mame: ects\WitraSonic SensonGas Meter - I'u'lorph‘.GasMorph_dem01GasI'-p10rphDemoPackage‘.h‘IeterConﬂg|

Files of Type: | All Files v

. Cpen | Cancel

Figure 13: Selecting a Configuration File in USS GUI

12. Click on “Request Update”. The green LED on MSP-EXP430FR5994 (LED1 on
bottom of board) should toggle and the GUI will show a message to indicate a
successful operation.

MSP430FR5994 Ultrasonic Gas Meter — Quick Start Guide
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13. Select the “ADC Waveform” tab and click on “Single Capture”. The GUI will request an
ADC capture of the Ultrasonic signals:

,
15950 s s i oua. SR

File Help

[CurigmiunTwm_
[ (sngecapue | (_Epon | [ clearcapire | |

ADC Graph

=)
=
g
&)
=}
<
0 20 40 60 B0 100 120 140 160 180 200 220 240 260 280 300 320 340 360 380 400
ADC sample
Ready.
e .y
Note:

The ADC waveform might look different than the image above but
it should have sufficient amplitude, the upstream and downstream
should look almost identical (without flow), and the complete
signals should be in the capture window.

For debugging information, please refer to Section 0.

MSP430FR5994 Ultrasonic Gas Meter — Quick Start Guide
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3.1

14. Select the “Waveforms” tab and click the “Start” button. The GUI will start plotting the
data received from the device:

B
g
§3
=
3]
g4

o)

W49 IS0 1052 1054 1056
Recelved Time

Figure 14: TOF Waveforms

Note:

For debugging information about the waveforms, please refer to
Section 5.

Flow Demo

The flow demo shows the capability of the Ultrasonic Gas Meter AFE to detect changes in air
flow rate.

Follow the next steps:

1. Change the air flow rate by adjusting the DC voltage of the power supply.

MSP430FR5994 Ultrasonic Gas Meter — Quick Start Guide
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of-Flight (TOF) and volume.

2. The GUI will show the effect of changing air flow in the Absolute and Differential Time-

The DC fan is expected to have an air flow of ~0.5CFM at 12V and 0.15CFM at 4V.

3 MSP430™ Ultrasonic Sensor Tool (== RS
File Help
Configuration | Waveforms T ADC Waveform ] I
Control Panel S
| Stop | [ Export J [ Clear Graphs J
Delta ToF 59
3E6 4E-9
'U“‘ 3E9
2566 e
—_ I 259
2L 26 ; 1E-2
e
O 15E6 » 'JE'?
- P -1E9
= 1E6 ™ 2E9
]
° r .
SE-7 I 3E9
]
OEQ - 00
1422 14:24 14:26 14:28 1420 1422 14:24 14:26 1420
Received Time Received Time
Absolute TOF Volume
151564 ~ 14,000 w
o) 1.51E-4 w %lE,IJIJIJ i
& 1.505E-4 } 5 10,000 .
= £ 8,000 W
o 15E4 ‘l =
= = 6,000 ”
= - W I
2 1.495E-4 “llll £ 4,000 -
=] 1 S
< 1.49E-4 ~— Pbsolute TOF UPS 3 2,000
fosolute TOF ONS = a
1.485E-4
14:22 14:24 14:26 14:28 14:30 14:22 14:24 14:26 14:30
Received Time Received Time
Ready.

Figure 15: GUI showing Air Flow

Adjusting Volume output

The “Volume” plot shows the flow rate as a factor of the TOF (absolute and differential) and a
meter constant.

This meter constant depends on the meter characteristics and the desired output units.

To adjust the volume, follow the next steps:

1. Select the “Configuration” window.

2. Change the “Meter Constant” parameter to a desired value (i.e. the meter constant

is directly proportional to the Volume output).

Meter constant:

3. Click the “Request Update” button

MSP430FR5994 Ultrasonic Gas Meter — Quick Start Guide
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3.3

Changing Number of Pulses

The number of pulses sent to the transducers determines the shape and amplitude of the

received signal.

The effect of changing number of pulses can be observed by following the next steps:

1. Select the “Configuration” Window.

2. Modify the “Number of Pulses” parameter to a desired value.

Mumber of Pulses:

3. Click the “Request Update” button.

4. Check the effect on the “ADC Waveform” tab.

1] B

kP MSPA30™ Ultrasonic Sensor Taol o[8[ = ]

% MSP430™ Ultrasonic Sensor Tool

[=[@] = |

File Help

File Help

[ configuration | wavetorms | ADC waveform |

[ configuration | wavetorms | ADG wavetorm |

Control Panel

Control Panel

[ sngecapure | | Epon | [ ciearcapure | ‘

‘[ singiecapture | [ Export | [ clearcapture

ADC Graph

1,200
1,100
1,000

900
800
700
600
500
400
300
200
100

0
-100 |[f
200
300
-400
500
600
700
-800
-800

-1,000

-1,100

-1,200

ADC value

ADG Up Stream -~ ADG Down Siream

0 20 40 60 B0 100 120 140 160 180 200 220 240 260 280 300 30 340 360 300 400
ADC sample

Ready

ADC value

Ready.

-100
200
-300
-400
500
600
700
-800
200

ADC Graph

900
800
700
600
500
400
300
200
100

0

ADC Up Stream ~— ADG Down Siream

0

20 40 60 80 100 120 140 160 180 200 220 240
ADC sample

260 280 300 320 340 360 380 400

Figure 16: Decreasing the Number of Pulses

MSP430FR5994 Ultrasonic Gas Meter — Quick Start Guide

13



I3 TEXAS

INSTRUMENTS

14

Customizing the Demo to Receive Signal from Different
Transducers/Pipes

1.

2.

Set hardware in Default configuration as shown in Figure 1 and Figure 2.

The MSP430FR5994 should come pre-programmed and ready to run, but if
necessary, re-flash the device following the steps described in Appendix A.

Connect MSP-EXP430FR5994 to Ultrasonic AFE BoosterPack aligning the
Launchpad/BoosterPack connectors as shown in Figure 7.

Connect the transducer terminal to the USS AFE BoosterPack.

The transducers should be connected to J1 and J2 in the Boosterpack, with the black
cable connected to each GND pin. The order of the connections is only important to
determine the direction of air flow.

If available, connect the ground shield of the pipe to connectors J5 or J6 in the AFE
BoosterPack.

Connect the MSP-EXP430FR5994 to the PC through USB using J102 connector.

Open the folder where the Ultrasonic GUI was extracted to (USS_GUI_1_00_02_04.zip)
and run the GUI by double-clicking USS_GUlI jar.

The GUI will start running in the disconnected state.

The GUI should run after a splash screen displaying the disconnected state as shown
in Figure 10.

The GUI will display all connected and enumerated COM ports. Select the port “MSP
Application UART1".

Click the “Connect” Button. The GUI should go to the connected state

Click on “Load Configuration” and select a configuration file inside MeterConfig/ which
can be used as a base to test the new transducers.

In this example, we will use the Ceramtec 400 configuration since the custom meter
uses 400Khz transducers, although the dimensions are different.

MSP430FR5994 Ultrasonic Gas Meter — Quick Start Guide
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Lo @ vy o
[ Minix-audiowell300_FR5994

994
| V_ceramiec400_fr5994

FileName:  \_ceramtecd00_fr5094 |

Files of Type: | Al Files '

Figure 17. Selecting Ceramtec 400Khz Configuration

10. The ADC Waveform might show a capture which is incorrect due to the propagation
time, transducer frequency, etc.

T =
File Help
[ configuration | waveforms _
Conirol Panel
ADC Graph
O - L e S + 1) SN N S——

ADC value
o

a 20 40 60 80 100 120 140 160 180 200 220 240 260 280 300 320 340 3260 380 400
ADC sample

Figure 18: Incorrect ADC Waveform Capture

The waveform from the ADC capture can be used to customize some of the GUI
parameters; however, this guide shows how to verify the physical connections to the

pipe.

MSP430FR5994 Ultrasonic Gas Meter — Quick Start Guide
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11. Connect an oscilloscope to pin labeled “15” on right BoosterPack connector and pin

“6” of left connector.

- Pin “15” is connected to the output pin, which based on our default configuration is
expected to generate 40 pulses of 360Khz-440Khz twice (once for Upstream and
once for Downstream) every ~850ms.

- Pin “6” is the signal obtained by the RX transducer, amplified by the dual-stage
amplifier, and going to the ADC input of MSP430FR5994.

Figure 19: Oscnloscope connected to AFE BoosterPack

The signals should look as below for a long capture:

—734.0ms 5.880V
314.0ms —320.0mv
A1.048 s AG.200V |

(@ 200V ® 100V ] ‘200ms ) |500k5/
0

h!il—lih

Figure 20: Long Oscilloscope Capture of Signals To/From Transducers

16 MSP430FR5994 Ultrasonic Gas Meter — Quick Start Guide
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e CH1 (in yellow) is connected to the output pin, while CH2 (in blue) is connected to
the ADC input.

o Note that there are multiple output “bursts” for each upstream/downstream. For
each output “burst”, there should be an input signal.
If no input is detected, this indicates a problem in the physical connection to one of
the transducers.

e The current default configuration is expected to generate 22 pulses every ~1
second.
10 + 1 dummy transfer for each upstream and downstream since our signal
sampling frequency is 2MSPS but our ADC sampling is 200KSPS.

e The gap between complete UPS/DNS sequences is defined by “DNS and UPS
gap”. In the capture above, the gap is ~850ms:

DME and UPS gap (msec): a50.098 Ej

12. Zoom-in on one of the captures as shown in the following figure:

M 1.00ms

5.880V |
~320.0mv
A6.200V |

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

(@ 200v @ toov ] ‘z 80.0ps T[Toomsss ‘ ‘
S e (3. 57600ms E2600ms J11m points

e [0 [ =

Figure 21: Oscilloscope Capture for one Ultrasonic Signal Capture

e The gap between each signal bursts is defined by “UPS and DNS gap”. In the
capture above, the gap is ~8ms:

LIPS and DMS gap:(usec) 3,000 E]
This parameter can be adjusted to ensure that the signal stabilizes before the next
capture, but it has an adverse effect on power consumption.

e The number of pulses sent on each burst is given by “Number of Pulses”. In the
capture above, the number of pulses is 40:

MSP430FR5994 Ultrasonic Gas Meter — Quick Start Guide 17
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Mumber of Pulses: 40 E]

This parameter can be customized to increase the amplitude of the received signal
at the expense of higher power consumption.

o The frequency of the transmitted pulses is defined by “Transmit Frequency”. In the
capture above, the device generates pulses between 360Khz and 440Khz. Note
that the device generates a modulated “multi-tone” pattern to generate a better
response from the transducers.

Transmit frequency (KHz): f1: 360.0 | f2 440.0 |_F'attern 3 ‘l’|
This parameter must be customized according to the excitation frequency of the
transducers.

e The gap between the output burst and ADC sampling is defined by “Gap between
pulse start and ADC capture”. Our default configuration uses 300us.

Gap between pulse start and ADC capture: (usec) 100 E]

This parameter must be customized according to the propagation delay of the
meter pipe. The oscilloscope capture above shows-a propagation delay of ~260us
for our new meter.

» The duration of the ADC capture is defined by “Capture Duration”:
Capture Duration (us): 200

This parameter must be adjusted according to the duration of the received signal.

The parameters above are commonly modified to obtain a proper signal. For a complete
description of the GUI parameters, please refer to http://www.ti.com/tool/TIDM-1002.

13. Modify the GUI parameters as needed.
The following modifications were done for the custom meter used in this example:
e As observed in the oscilloscope capture, the only necessary modification is the
“Gap between pulse start and ADC capture”.
To ensure a complete sampling of the signal, this example sets the gap to 240us:

Gap between pulse start and ADC capture: (usec) 540 E

e Additionally, we will set the number of pulses to 30 and reduce the capture
duration to 180us:

Capture Duration (us): 180 E]

Mumber of Pulses: 30 E]

14. Update the configuration by clicking “Request Update”

18 MSP430FR5994 Ultrasonic Gas Meter — Quick Start Guide
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15. Take an ADC Waveform Capture to check the effect on the signal:

File Help

[ contguraton | wawstorns | AbG wavetorn |

900
800
700
600
500
400
300
200 1|
100 1|

-100
-200
-300
-400
-500
-600
-700
-800
-900

ADC value
o

80 100

[ s.nmcam] [ EBpot | | Clearcapture |

ADC Graph

120 140 160 180 200 220 240 260 280 300 320 340 360
ADC sample

v
Ready

5

Figure 22: Correct Qwvm()rm after Adjusting Parameters

If needed, repeat st \

djust the signal response.

MSP430FR5994 Ultrasonic Gas Meter — Quick Start Guide
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5 FAQs and Troubleshooting

e Q: GUI doesn’t recognize EVM
A:
- Make sure MSP-EXP430FR5994 is connected to PC.
- The device should also be recognized by Windows Device Manager:

- <" MSP Application UART1 (COM229)

- Drivers are needed for proper operation. TlI recommends installing the drivers
by installing an IDE such as TI CCS or IAR EW430. Drivers are also available
at http://www.ti.com/MSPdrivers.

- Click the Refresh Button on the GUI to

- If needed, try restarting the GUI.

e Q: GUI is not updating device after loading a new configuration
A:

- Try pressing the “Request Button” again. The MSPFR5994 is usually in LPM3
mode, and some devices can miss the “Wake-up” event sent by the GUI at a
baudrate of 57,600bps. In such case, LED1 on the MSP-EXP430FR5994 won'’t
turn on when the update is requested.

- Try re-flashing the device as described in Appendix A.

- Some configurations might not be supported by the device. The current GUI
won’t display an error message, but the LEDs on MSP-EXP430FR5994 will
stay ON to indicate an error. If so; try a different configuration.

e Q: ADC Waveform looks incorrect
A:

- The pipe and transducers are only provided for demo purposes and they were
not manufactured for high robustness. The default configurations provided in
MeterConfig/ were tested before shipment but a misalignment or change of
position of transducers during transportation might affect the results. In such
case, try re-adjusting the cables and/or the position of the transducers.

- Verify the polarity of the transducers by swapping the connection of the red
and black cables.

- Try adjusting the “Gap between pulse start and ADC capture” in the GUI. This
parameter adjusts the propagation delay in case the received signal is not
centered properly on the ADC capture

e Q: Delta TOF (dTOF) and Volume data in Waveform window looks noisy
A:

- The GUI adjusts the zoom automatically depending on the input. If the dTOF is
not varying much, the signal will look noisy even though the change is minimal.
Try changing the air flow rate to observe a more noticeable change.

- Gas meters are usually placed inside a shielded case to reduce noise. In such
case, connect the GND shield to the Ultrasonic AFE Boosterpack GND using
connectors J5 and J6.

- A USB cable with ferrite can help reduce noise when connected to PC.

- A clean power supply can help reduce noise.

20 MSP430FR5994 Ultrasonic Gas Meter — Quick Start Guide
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e Q: Delta TOF (dTOF) or Volume doesn’t vary perfectly proportional to the DC
voltage

A:

e Q
A
e Q

The DC fan provided for demo purposes is not highly accurate.

: There is variation when the fan is off.

Zero-Flow-Drift (ZFD) tests are typically performed to observe the expected
variation of the system and determine the minimum detectable flow. These
tests require the meter to be sealed to reduce air flow to the minimum possible.
Gas meters are usually placed inside a shielded case to reduce noise. In such
case, connect the GND shield to the Ultrasonic AFE Boosterpack GND using
connectors J5 and J6.

A USB cable with ferrite can help reduce noise when connected to PC.

A clean power supply can help reduce noise.

: What is the air flow range tested with this reference design.
A:

The 12V DC fan included for demo purposes was measured to have a flow rate
of approximately ~0.5CFM at 12V and ~0.15CFM at 4V.

The reference design <has been tested with other fans and meter
configurations, including a 2.9CFM fan discussed in TIDM-1002.
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Appendix A. Flashing the binaries

LaunchPad must be connected to USB using the default configuration discussed in Figure 1.

Unzip MSPFlasher_1.3.10.zip and place it in the following location:

C:\ti\MSPFlasher 1.3.10

Note:

The installation folder can differ but this will affect the
execution of the batch file used for this example.

Open the binaries in Windows explorer and go to the following location:

binaries\v_1_10 _00_11

Drag-and-drop the binary file (msp-expfr5994 gas_afe_bp_fire_capture_processing.txt) into

Program_App.bat

MSP430Flasher.exe can also be used to program the device without
using the batch file. Check MSP430 Flasher documentation for more
details (http://www.ti.com/tool/msp430-flasher ).

= E=ir=] (B8 E=R 3
@@v\ J « ti » MSPFlasher 1310 » - |‘?|| Search MS r13. P| @U=| J <« binaries » v_1_1000_11 v|¢y|| Search v_1_10.00 11 o
Organize » Open Print MNew folder iz« Al @@ Organize » j Open = Sharewith = » ==« [l lé.'
-
i Name Date modified Type o .- :
@ L v T e enan ns weusun 1 Work “brary Arrange by:  Folder =
| Licensetut Text Document A T
= MSP_Flasher_Software_Manifest.pdf Adobe Acrobat ] 1 Mame
wd
= (%] MSP430.dIl Application exte = =
E > o || msp-expfr3994_gas_afe_bp_fire_capture processing bt
~2 MSP430Flasher.exe Application
3 %] Program MSP430 (exarnple).bat Windows Batch
£ . 1=
J 95| Program MSP432 (exarple).bat Windows Batch| ™
= 4] Program_Apqkat Windows Batch
E | README. + Open with Program_App.bat Text Document
= || uninstall.dat 1/18/2017 2:54 PM  DAT File -
- d L1} 3 ]| <] i} 2
~. | Program_App.bat Date modified: 2/27/2017 3:53 AM & msp-expfrs994_gas_afe_bp fire_capture processing txt
™'} Windows Batch File Size: 104 bytes Text Document
Note:

MSP430 Flasher should detect the LaunchPad and program the device:
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#* Driver
= D11 Uersion
= Fulersion
= Interface
* HwlUersion
B
B
I
I

Erase Mode
* Prog.File
onic SensorsGa

TRUE
BSL Unlock

BN Chwindows\system32\cmd.exe === @

loaded

: 30361000

3B8ABAR2
TIUSE
E 5.8

AUTO

M5P43AFRS 974

Level 5, GClockCntrl 2

o A

GC:sUsershal2?26B0 Documents~Work~Active projects“ProjectssUltral
Meter — MorphsGasMorph_demo~GazMorphDemoPackagesbinariessv_1_18

BB_11“msp-expfr5?74_gas_afe_bp fire_ captWed Jun 87 15:57:53 2817= Verified H
: FALSE

Starting target code execution...done
Disconnecting from device...done
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1. Open a workspace in CCS

Appendix B. Importing and Building

2. Select Menu->Project->Import CCS Projects

Project in CCS

3. Inthe new window, select the following search directory:
C:\ti\msp\gasLibrary 1 10 00 1l\examples\ExampleProjects\msp-

expfr5994 gas afe bp\CCS

Note:

The Gas Library folder can vary depending on its installation.

4. CCS should discover the project:

"« Import CCS Eclipse Projects

Select CCS Projects to Import

Select a directory to search for existing CC5 Eclipse projects.

4 1L}

Copy projects into workspace

@ Select search-directory:  pleProjects\msp-expfr5994_gas_afe_bp\CCS Browse...

1 Select archive file: Browse...
Discovered projects:
£ msp-expfr5994_gas_afe_bp_fire_capture_processing [C:\t1ms Select All

Autornatically import referenced projects found in same search-directory

Open the Resource Explorer to browse available example projects...

I G

Deselect All

Refresh
3

Finish l [ Cancel

5. Click on “Finish”
6. The project will be imported into CCS

7. Build the project
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+'¢ CCS Edit - Code Composer Studio = =]
File Edit View MNavigate Project Run Scripts Window Help
g B/ @i FviEin Oy Quick Access % | [ CCodit | 5 CCS Debug
[ Project Explorer &3 = B8 = 8
B% ¥
4 5 msp-expfr5994 gas afe_bp _fire
» # Binaries
» i) Includes
> (= common
» (= Debug
> (= driverlib
» (= GASMeteringlibraryConfig
» (= targetConfigs
> [8 hmic
> [8 hmih
» [ Ink_mspd30fr5994.cmd
> [8) main.c
B Console 2 = B | [2] Problems 57 ] Advice 47 Search ¥ =8
A B S| B - - | ditems .
CDT Build Console [msp-expfi5894_gas_afe_bp_fire_capture_processing] | Description Resource
CS/gastetering.a” -1libc.a .
<Linking>
"Finished building target:
msp-expfrs994_gas_afe_bp_fire_capture_processing.out
#*s Build Finished ****
« i v 0 v
o] Full License
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1. OpenlAR

Appendix C. Importing and Building

Project in IAR

2. Select Menu->File->Open Workspace and open the following file:
C:\ti\msp\gasLibrary 1 10 00 ll\examples\ExampleProjects\msp-
expfr5994 gas afe bp\IAR\Gas Metering examples worspace.eww

The Gas Library folder can vary depending on its installation.

Note:

%vl | <« gaslibrary 1100011 » examples » ExampleProjects » msp-expfr5994_gas_afe bp » IAR »

Iﬁmﬁnmm

[ 43 |[ Searcn 147 2|

Organize New folder = 0O @

b4 Name . Date modified Type Size

t . CSPYmacre B6/7/20171:52PM  File folder

i |\ Debug B/7/20171:53PM  File folder

i . settings 6/7/20171:58 PM File folder

i [#] Gas_Metering_examples worspace.eww  4/26/20171:45 PM  IARIDE Workspace 1KB

&

v| Waorkspace Files [".eww) -

3. AR will open the workspace, incl
expfr5994 gas_afe_bp_fi é%

4, uild the project

File Edit View Project Emulator

Tools Window Help

\J

D@ HP &% R0 >
‘Workspace

o
[ driveribs
[ GASMeteringLibraryConfig

himi.c

|— B hrich

b— [ Ink43015334xcl
main.c

3 Output

|— [ gasMetering_IAR_large_code_large_data lib

msprexph5334_gas_ste_bp_fire_caphure_processi

ing

YA PPER YRS DD

Messages
timer_a.c
fimer_b.c
thec
wil_a.c
Linking

Total number of errors:
Total number of warnings: 0

Ready

[— | Errors 0, Warnings 1
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1. Program the EVM as described in

Appendix D. Customizing the Demo

2. Select Menu->File->Open Workspace and open the following file:

C:\ti\msp\gasLibrary 1 10 00 1ll\examples\ExampleProjects\msp-

expfr5994 gas afe bp\IAR\Gas Metering examples worspace.eww

Note:

The Gas Library folder can vary depending on its installation.

= <« ibrary 1 10 0011 » examples » mpleProjects » msp-ex) |_gas_afe | > 3
gasLibrary 110 00_11 ples » ExampleProj p-expfr5004_gas_afe bp » IAR

Iﬁn@hmm

[ 43 |[ Searcn 14R 2|

Organize + New folder =~ 1 @

b4 Name . Date modified Type Size

t |. CSPYmacro 6/7/2017 1:52 PM File folder

3 |\ Debug 6/7/2017 1:53 PM File folder

i . settings 6/7/2017 1:58 PM File folder

a [#] Gas_Metering_examples_worspace.eww  4/26/20171:15PM  1ARIDE Workspace 1KB

=

~| [ Workspace Files (r.euw) -

3. 1AR will open the works

4, uild the project

File Edit View Project Emulator Tools Window Help

D@ P S BR[o >

ARl ELEY I E L A

I common

[ driverlibs

[ GASMeteringLibranyConfig

|— [ gasMetering_LAR_large_code _large_dete.lib
himi.c

|— B hrich

f— B Inkd30r5 884l

main.c

(3 Output

mspexph5334_gas_ate_bp_fire_caphuas_processing

Messages
timer_a.c
timer_b.c
e
wil_a.c
Linking

Total number of enrars: 0
Total number of warnings: 0

1 3

Ready

[— | Eors 0, Warnings 1 »
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IMPORTANT NOTICE FOR TI APPLICATION NOTE INFORMATION AND
RESOURCES

Texas Instruments Incorporated (‘TI”) technical, application or other design advice, services or information, including, but not limited to,
reference designs and materials relating to evaluation modules, (collectively, “TI Resources”) are intended to assist designers who are
developing applications that incorporate Tl products; by downloading, accessing or using any particular Tl Resource in any way, you
(individually or, if you are acting on behalf of a company, your company) agree to use it solely for this purpose and subject to the terms of
this Notice.

TI's provision of Tl Resources does not expand or otherwise alter TI's applicable published warranties or warranty disclaimers for Tl
products, and no additional obligations or liabilities arise from TI providing such Tl Resources. Tl reserves the right to make corrections,
enhancements, improvements and other changes to its TI Resources.

You understand and agree that you remain responsible for using your independent analysis, evaluation and judgment in designing your
applications and that you have full and exclusive responsibility to assure the safety of your applications and compliance of your applications
(and of all TI products used in or for your applications) with all applicable regulations, laws and other applicable requirements. You

represent that, with respect to your applications, you have all the necessary expertise to create and implement safeguards that (1)
anticipate dangerous consequences of failures, (2) monitor failures and their consequences, and (3) lessen the likelihood of failures that
might cause harm and take appropriate actions. You agree that prior to using or distributing any applications that include TI products, you
will thoroughly test such applications and the functionality of such Tl products as used in such applications. Tl has not conducted any
testing other than that specifically described in the published documentation for a particular Tl Resource.

You are authorized to use, copy and modify any individual TlI Resource only in connection with the development of applications that include
the TI product(s) identified in such Tl Resource. NO OTHER LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE TO ANY
OTHER TI INTELLECTUAL PROPERTY RIGHT, AND NO LICENSE TO ANY TECHNOLOGY OR INTELLECTUAL PROPERTY RIGHT OF
TI OR ANY THIRD PARTY IS GRANTED HEREIN, including but not limited to any patent right, copyright, mask work right, or other
intellectual property right relating to any combination, machine, or process in which Tl products or services are used. Information regarding
or referencing third-party products or services does not constitute a license to use such products or services, or a warranty or endorsement
thereof. Use of TI Resources may require a license from a third party under the patents or other intellectual property of the third party, or a
license from TI under the patents or other intellectual property of TI.

TI RESOURCES ARE PROVIDED “AS IS” AND WITH ALL FAULTS. Tl DISCLAIMS ALL OTHER WARRANTIES OR
REPRESENTATIONS, EXPRESS OR IMPLIED, REGARDING TI RESQURCES OR USE THEREOF, INCLUDING BUT NOT LIMITED TO
ACCURACY OR COMPLETENESS, TITLE, ANY EPIDEMIC FAILURE WARRANTY AND ANY IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL
PROPERTY RIGHTS.

TI SHALL NOT BE LIABLE FOR AND SHALL NOT DEFEND OR INDEMNIFY YOU AGAINST ANY CLAIM, INCLUDING BUT NOT
LIMITED TO ANY INFRINGEMENT CLAIM THAT RELATES TO OR IS BASED ON ANY COMBINATION OF PRODUCTS EVEN IF
DESCRIBED IN TI RESOURCES OR OTHERWISE:IN NO EVENT SHALL Tl BE LIABLE FOR ANY ACTUAL, DIRECT, SPECIAL,
COLLATERAL, INDIRECT, PUNITIVE, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES IN CONNECTION WITH OR
ARISING OUT OF TI RESOURCES OR USE THEREOF, AND REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

You agree to fully indemnify Tl and its representatives against any damages, costs, losses, and/or liabilities arising out of your non-
compliance with the terms and provisions of this Notice.

This Notice applies to Tl Resources. Additional terms apply to the use and purchase of certain types of materials, Tl products and services.
These include; without limitation, TI's standard terms for semiconductor products http://www.ti.com/sc/docs/stdterms.htm), evaluation
modules, and samples (http://www.ti.com/sc/docs/sampterms.htm).

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
s: Texas Instruments, Post Office Box 655303, Dalla

Copyright © 2017, Texas Instruments Incorporated
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